Training Document
for Comprehensive Automation Solutions
Totally Integrated Automation (TIA)

MODULE E10
Component Based Automation (CBA)

with
2x CPU 315F-2 PN/DP

and
iMAP
This document has been written by Siemens AG for training purposes for the project entitled "Siemens Automation Cooperates with Education (SCE)". Siemens AG accepts no responsibility for the correctness of the contents.

Transmission, use or reproduction of this document is only permitted within public training and educational facilities. Exceptions require the prior written approval by Siemens AG (Michael Knust michael.knust@siemens.com).

Offenders will be liable for damages. All rights, including the right to translate the document, are reserved, particularly if a patent is granted or utility model is registered.

We would like to thank the following: Michael Dziallas Engineering, the teachers at vocational schools, and all others who helped to prepare this document.
The following symbols are provided as a guide through Module E10:

- **Information**
- **Programming**
- **Sample Exercise**
- **Notes**
1. PREFACE

In terms of its contents, Module E10 is part of the teaching unit entitled 'IT Communication with SIMATIC S7'.

Learning Objective:

In Module E10, the reader learns networked how two stations can be generated as CBA components, in order to be networked with iMAP into an overall project. The two stations CPU 315F-2 PN/DP are used as PLCs. They are interconnected by means of PROFINET. Module E10 shows the method in principle, using a brief example.

Prerequisites:

To successfully work through Module E10, the following knowledge is assumed:

- Knowledge in handling Windows
- Fundamentals of PLC programming with STEP 7 (for example, Module A3 - 'Startup' PLC Programming with STEP 7)
- Fundamentals of network engineering (for example, Appendix V - Basics of Network Engineering)
Hardware and software required

1. PC, operating system Windows 2000 Professional starting with SP4/XP Professional starting with SP1/Server 2003 with 600MHz and 512RAM, free hard disk storage 650 to 900 MB, MS Internet Explorer 6.0 and network card
2. Software STEP7 V 5.4
3. Software iMAP V3.0
4. PLC SIMATIC S7-300 with CPU 315F-2 PN/DP and at least one digital input and output module
   Sample configuration:
   - Power supply: PS 307 2A
   - CPU: CPU 315F-2 PN/DP
   - Digital inputs: DI 16x DC 24V
   - Digital outputs: DO 16x DC 24V/0.5A
5. PLC SIMATIC S7-300 with CPU 315F-2 PN/DP and at least one digital input and output module:
   Sample configuration:
   - Power supply: PS 307 2A
   - CPU: CPU 315F-2 PN/DP
   - Digital inputs: DI 16x DC 24V
   - Digital outputs: DO 16x DC 24V/0.5A
6. Ethernet connection between PC and CPUs 315F-2 PN/DP
2. NOTES ON USING THE CPU 315F-2 PN/DP

The CPU 315F-2 PN/DP is a CPU that is shipped with 2 integrated interfaces.
- The first interface is a combined MPI/PROFIBUS-DP interface that can be used on the PROFIBUS DP as master or as slave for connecting distributed IO/field devices with very fast response timing.
  In addition, the CPU can be programmed here by means of MPI or PROFIBUS DP.
- The second interface is an integrated PROFINET interface.
  It allows for using the CPU as a PROFINET IO controller for operating distributed IO on the PROFINET. Also, the CPU can be programmed by means of this interface!
- Fault tolerant IO devices can also be used on both interfaces.

Notes:
- In Module E10, the CPU 315F-2 PN/DP is used as controller in a CBA component on the PROFINET.
- To operate this CPU, a micro-memory card is required!
- The addresses of the input and output modules can be parameterized at this CPU.

3. NOTES ON COMPONENT BASED AUTOMATION (CBA) AND IMAP
4. STARTING UP A CBA-PROJECT WITH 2X CPU 315F-2 PN/DP

Below, the startup of a CBA project with two stations is described. A CPU 315F-2 PN/DP is used in both stations as controller.

To test the configuration, a program is written in which from each station, the application can be started and stopped also in the other station.

A started application is indicated here representatively with a lamp.

Assignment List Station1:
I 0.0  S11_Start  Button Plant(s) Start1
I 0.1  S12_Stop  Button Plant(s) Stop1 (break contact)
O 4.0  P11_Start  Display Plant1 started

Assignment List Station2:
I 0.0  S21_Start  Button Plant(s) Start2
I 0.1  S22_Stop  Button Plant(s) Stop2 (break contact)
O 4.0  P21_Start  Display Plant2 started

1. The central tool in STEP 7 is the 'SIMATIC Manager'. It is called here with a double click. (→ SIMATIC Manager)

2. STEP7 programs are managed in projects. We are now setting up such a project. (→ File → New)
3. The project is now assigned the 'Name' 'CPU315F_CBA_iMAP' (→ CPU315F_CBA_iMAP → OK)

4. Highlight your project and insert an 'Industrial Ethernet Subnet' (→ CPU315F_CBA_iMAP → Insert → Subnet → Industrial Ethernet).
5. Then, a 'SIMATIC 300 Station' is inserted. (→ Insert → Station → SIMATIC 300 Station)

6. Change the name of the station to 'Station1'. (→ Station1)
7. With a double click, open the configuration tool for the 'Hardware'. (→ Hardware)
8. Open the hardware catalog by clicking on \[\text{folder}\]. (→)

There, arranged in the following directories:
PROFIBUS DP, PROFIBUS PA, PROFINET IO, SIMATIC 300, SIMATIC 400,
SIMATIC PC Based Control, and SIMATIC PC Station,
all racks, modules and interface modules are provided for configuring your hardware.
Insert 'Rail' with a double click. (→ SIMATIC 300 → RACK 300 → Rail).

\[\text{Image of hardware catalog}\\]

**Note:** After that, a configuration table is displayed automatically for configuring Rack 0.
9. From the hardware catalog, you can now select all modules that are also in your real rack, and insert them in the configuration table.

To this end, click on the name of the respective module, hold the mouse key and drag the module to a line in the configuration table.

We are starting with the power unit 'PS 307 2A'. (→ SIMATIC 300 → PS-300 → PS 307 5A)

![Configuration Table Example]

**Note:** If your hardware differs from the one displayed here, simply select the corresponding modules from the catalog and insert them in your rack. The order numbers of the individual modules -that are also indicated on the components- are displayed in the footer of the catalog.
10. Next, we are dragging the 'CPU 315F-2 PN/DP' to the second slot. The order number and the version of the CPU can be read off the front of the CPU.

   \(\rightarrow\) SIMATIC 300 \(\rightarrow\) CPU-300 \(\rightarrow\) CPU 315F-2 PN/DP \(\rightarrow\) 6ES7 315-2FH13-0AB0 \(\rightarrow\) V2.6

11. When entering the CPU, the window below appears. In this window, do the following:
Assign an 'IP Address' to the CPU 315F-2 PN/DP, specify the 'Subnet Screen Form', and select the 'Ethernet' network that has already been generated.
Optional: a 'Router Address' can also be selected for network-overreaching communication.
Confirm your input with 'OK' \(\rightarrow\) IP Address: 192.168.0.1 \(\rightarrow\) Subnet screen form: 255.255.255.0 \(\rightarrow\) Ethernet(1) \(\rightarrow\) Don't use a router \(\rightarrow\) OK
Notes on Networking on the Ethernet (additional information is provided in Appendix V of the training document):

**MAC Address:**
The MAC address consists of a permanent and a variable part. The permanent part ("Basis MAC Address") identifies the manufacturer (Siemens, 3COM, ...). The variable part of the MAC address differentiates the different Ethernet stations, and should be assigned uniquely world-wide. On each module, a MAC address specified by the factory is imprinted.

**Value range for the IP address:**
The IP address consists of 4 decimal numbers from the value range 0 to 255 which are separated by a period; for example 141.80.0.16

**Value range for the subnet screen form:**
This screen form is used in order to recognize whether a station or its IP address is part of the local subnet, or can be accessed only by means of a router. The subnet screen form consists of 4 decimal numbers from the value range 0 to 255 which are separated by a period; for example, 255.255.0.0

In their binary representation, the 4 decimal numbers of the subnet screen form have to contain from the left a series of gapless values "1" and from the right a series of gapless values "0". The values "1" determine the area of the IP address for the network number. The values "0" determine the area of the IP address for the station address.

Example:
Correct values: 255.255.0.0 decimal = 1111 1111.1111 1111.0000 0000 0000 0000 binary
255.255.128.0 decimal = 1111 1111.1111 1111.1000 0000 0000 0000 binary
255.254.0.0 decimal = 1111 1111.1111 1110.0000 0000 0000 0000 binary
Incorrect value: 255.255.1.0 decimal = 1111 1111.1111 1111.0000 0001.0000 0000 binary

**Value range for the address of the network transition (Router):**
The address consists of 4 decimal numbers from the value range 0 to 255 which are separated by a period; for example, 141.80.0.1.

**Relationship of IP addresses, router address, and subnet screen form:**
The IP address and the address of the network transition may differ only in positions that have a "0" in the subnet screen form.

Example:
You entered: for the subnet screen form 255.255.255.0; for the IP address 141.30.0.5, and for the router address 141.30.128.1.
The IP address and the address for the network transition are to have a different value only in the 4th decimal number. In the example, however, the 3rd position already differs.
In the example, you have to change alternatively:
- the subnet screen form to: 255.255.0.0 or
- the IP address to: 141.30.128.5 or
- the address of the network transition to: 141.30.0.1
12. Next, we are dragging the input submodule for 16 inputs to the 4th slot. The order number of the submodule can be read off the front. (SIMATIC 300 → DI-300 → SM 321 DI16xDC24V).

Note: Slot 3 is reserved for the interface modules and remains empty for that reason. The order number of the module is shown in the footer of the catalog.
13. Now we are dragging the output submodule for 16 outputs to the 5th slot. The order number of the submodule can be read off the front. (→ SIMATIC-300 → DO-300 → SM 322 DO16xDC24V/0.5A).

![Image of a SIMATIC module configuration]

**Note:** The order number of the module is shown in the footer of the catalog.

14. Now, the PROFINET interface has to be parameterized for CBA. With a double click, select 'PN IO'. (→ PN IO)
15. Under the tab ‘PROFINET’, activate ‘CBA Communication’. (→ PROFINET → CBA-Communication → OK)

16. By clicking on [ ] , the configuration table is saved and compiled. (→ [ ] )
17. Then, an additional 'SIMATIC 300 Station' is inserted. (→ Insert → Station → SIMATIC 300 Station)

18. Change the name to 'Station2'. (→ Station2)
19. With a double click, open the configuration tool for the 'Hardware'. (→ Hardware)
20. Open the hardware catalog by clicking on the symbol \[\text{Catalog}\]. ([\rightarrow])

There, arranged in the following directories:
- PROFIBUS DP
- PROFIBUS PA
- PROFINET IO
- SIMATIC 300
- SIMATIC 400
- SIMATIC PC Based Control
- SIMATIC PC Station

all racks, modules and interface modules are provided for configuring your hardware.

Insert 'Rail' with a double click ([\rightarrow] SIMATIC 300 [\rightarrow] RACK 300 [\rightarrow] Rail).

**Note:** After that, a configuration table for configuring Rack 0 is displayed automatically.
21. From the hardware catalog, you can now select all modules that are also in your real rack, and insert them in the configuration table. 

To this end, click on the name of the respective module, hold the mouse key and drag the module to a line in the configuration table. 

We are starting with the power unit 'PS 307 2A' (SIMATIC 300 → PS-300 → PS 307 5A) 

Note: If your hardware differs from the one displayed here, simply select the corresponding modules from the catalog and insert them in your rack. The order numbers of the individual modules -that are also indicated on the components- are displayed in the footer of the catalog.
22. Next, we are dragging the 'CPU 315F-2 PN/DP' to the 2nd slot. The order number and the version of the CPU can be read off the front of the CPU.  
(→ SIMATIC 300 → CPU-300 → CPU 315F-2 PN/DP → 6ES7 315-2FH13-0AB0 → V2.6)

23. When entering the CPU, the window below appears. In this window, do the following:  
Assign an 'IP Address' to the CPU 315F-2 PN/DP, specify the 'Subnet Screen Form', and select the 'Ethernet' network that has already been generated.  
Optional: a 'Router Address' can also be selected for network-overreaching communication.  
Confirm your input with 'OK' (→ IP Address: 192.168.0.2 → Subnet screen form: 255.255.255.0 → Ethernet(1) → Don't use a router → OK)
Notes on Networking on the Ethernet (additional information is provided in Appendix V of the training document):

MAC Address:
The MAC address consists of a permanent and a variable part. The permanent part ("Basis MAC Address") identifies the manufacturer (Siemens, 3COM, ...). The variable part of the MAC address differentiates the different Ethernet stations, and should be assigned uniquely world-wide. On each module, a MAC address specified by the factory is imprinted.

Value range for the IP address:
The IP address consists of 4 decimal numbers from the value range 0 to 255 which are separated by a period; for example 141.80.0.16

Value range for the subnet screen form:
This screen form is used in order to recognize whether a station or its IP address is part of the local subnet, or can be accessed only by means of a router. The subnet screen form consists of 4 decimal numbers from the value range 0 to 255 which are separated by a period; for example, 255.255.0.0

In their binary representation, the 4 decimal numbers of the subnet screen form have to contain from the left a series of gapless values "1" and from the right a series of gapless values "0". The values "1" determine the area of the IP address for the network number. The values "0" determine the area of the IP address for the station address.

Example:
Correct values: 255.255.0.0 decimal = 1111 1111.1111 1111.0000 0000 0000 binary
255.255.128.0 decimal = 1111 1111.1111 1111.1000 0000 0000 0000 binary
255.254.0.0 decimal = 1111 1111.1111 1110.0000 0000 0000 0000 binary
Incorrect value: 255.255.1.0 decimal = 1111 1111.1111 1111.0000 0000 0000 binary

Value range for the address of the network transition (Router):
The address consists of 4 decimal numbers from the value range 0 to 255 which are separated by a period; for example, 141.80.0.1.

Relationship of IP addresses, router address, and subnet screen form:
The IP address and the address of the network transition may differ only in positions that have a "0" in the subnet screen form.

Example:
You entered: for the subnet screen form 255.255.255.0; for the IP address 141.30.0.5, and for the router address 141.30.128.1.

The IP address and the address for the network transition are to have a different value only in the 4th decimal number. In the example, however, the 3rd position already differs.
In the example, you have to change alternatively:
- the subnet screen form to: 255.255.0.0 or
- the IP address to: 141.30.128.5 or
- the address of the network transition to: 141.30.0.1
24. Next, we drag the input submodule for 16 inputs to the 4th slot. The order number of the submodule can be read off the front. (SIMATIC 300 → DI-300 → SM 321 DI16xDC24V).

Note: Slot 3 is reserved for interface modules and remains empty for that reason. The order number of the module is shown in the footer of the catalog.
25. Next, we are dragging the output submodule for the 16 outputs to the 5th slot. The order number of the submodule can be read off the front. ($\rightarrow$ SIMATIC-300 $\rightarrow$ DO-300 $\rightarrow$ SM 322 DO16xDC24V/0.5A).

Note: The order number of the module is displayed in the footer of the catalog.

26. Now, the PROFINET interface for CBA has to be parameterized. With a double click, select 'PN-IO'. ($\rightarrow$ PN-IO)
27. Under the tab 'PROFINET', activate 'CBA Communication'. (→ PROFINET → CBA Communication → OK)

28. By clicking on [OK], the configuration table is saved and compiled. (→ [OK])
29. To make communication of Station1 with other stations by means of CBA possible, we have to generate a PROFINET interface "Generate PROFINET Interface". (→ Station1 → Generate PROFINET Interface)

30. Select the 'Add function'. (→ Add function)
31. Click on the right mouse key, and select 'Rename function'. (→ Rename function)

32. Rename the station 'Station1_Start_Stop'. (→ Station1_Start_Stop)
33. Then select 'Add PN block'. (→ Add PN block)

34. Assign 'DB10' as name und, as shown, a 'Symbolic name' and 'Symbol comment'. (→ DB10 → OK)
35. Highlight 'DB10', and by clicking on the arrow pointing up, assign a block ('Baustein zuordnen'). (→ DB10)

36. After 'DB10' is entered as assigned PN block ('Zugeordneter PN-Baustein'), 'Open' it. (→ DB10 → Öffnen)
37. Now, declare the variables 'PN_Input', 'IN_Start' and 'IN_Stop' in the format 'Bool'. (→ IN_Start → IN_Stop)

38. Then, declare the variables 'PN_Output', 'OUT_Start' and 'OUT_Stop' in the format 'Bool'. (→ OUT_Start → OUT_Stop)
39. 'Save' the interface and check CBA consistency by clicking on the symbol \(\rightarrow\). ([Image]

40. If the consistency check has been completed without error, close the window by clicking on \(\times\). ([Image]

<<PROFINET Interface Editor (319-417) CBA consistency check of all active CBA PN blocks completed without fault>>
41. Now, generate your user program by inserting a 'Function' in the folder 'Blocks' as a 'New object'. (→ Blocks → Insert new object → Function)

42. Assign 'FC1' as name, and as shown, a 'Symbolic Name' and 'Symbol comment'. (→ FC1 → OK)
43. With a double click, open the 'Symbol' table in the folder 'S7 Program(1)'.

44. As shown below, enter the symbols for this station and 'Save' them.
45. Now, with a double click, open the 'FC1' in the folder 'Blocks'. (→ Blocks → FC1)
46. Generate FC1 as shown here, and 'Save' it. The variables in the PN block DB10 can be accessed using their symbolic name. ($\rightarrow$)

---

**Network 1: Start/Stop of plant**

- **E0.0** Button
- **DE10.DX0.0** 
  - CBA Start
  - Stop

- **DE10.DX0.1** 
  - CBA Start
  - Stop

**Network 2: Send start signal to other stations**

- **E0.0** Button
  - Plant(s) Start
  - "$11_{Start}$"

- **DE10.DX2.0**
  - CBA Start
  - Stop

**Network 3: Send stop signal to other stations**

- **E0.1** Button
  - Plant(s) Stop
  - (break contact)
  - "$11_{Stop}$"

- **DE10.DX2.1**
  - CBA Start
  - Stop
47. With a double click, open 'OB1' in the folder 'Blocks'. (→ Blocks → OB1)

48. As programming language, select 'FBD' and confirm with 'OK'. (→ FBD → OK)
49. Generate OB1 also as shown here, and 'Save' it. Close the application by clicking on \(\times\). (→  \\

50. If DB10 is generated as PN interface, and all other program blocks are written also, check the block consistency \(\rightarrow\). (→ Blocks \(\rightarrow\) Check block consistency)
51. By clicking on the symbol 'Compile everything', select 'Compile everything'. (→)

52. Close all other applications that could access your blocks and confirm with 'OK'. (→ OK)

<<The application "Check block consistency" uses all editors (for example, LAD/STL/FBD) exclusively for the following compilation run. Please close all editors or the edited sources in the editors.>>
53. Errors and warnings of the compilation run are indicated. Now close the window. (→ X)

54. Now, we have to generate the PROFINET component for ‘Station1’, ‘Generate PROFINET component’. (→ Station1 → Generate PROFINET component)
55. When making the settings for the component, you can/have to assign the name of the component, the device name, and the version in the first window 'General'. (→ General)

56. In the second window, assign the following settings for the 'Component type'. (→ Component type)
57. The name of the function with the interface block DB10 is then displayed under the tab 'Functions'. (→ Functions)

58. Under the tab 'Storage locations', the directory for storing the component is selected. (→ Storage locations)
59. Under 'Supplementary Properties', the paths for the display files are specified. Accept the component with 'OK'. (→ Supplementary Properties → OK)

60. Accept the message regarding the cycle load that may possibly be displayed with 'OK'. (→ OK)

<<The CPU parameter 'Cycle load through communication' is less than the value shown below. You can set the parameter under the tab 'Cycle/Clock Flag' in the CPU property dialog box. Do you want to continue?>>
61. Repeat items 29. to 60. for Station2 with the component name: "station2_start_stop".

62. Now you have set up, in the selected path, the two components for both stations. Below, these are wired, parameterized, and started up with SIMATIC iMAP.

- Local Data Carrier (D:)
  - 00_Drives
  - 00_IMap
    - station1_start_stop-{10152b96-7c5f-4a50-35f5-e60d4c262269}-0.0.0.0
    - station2_start_stop-{5d15d9c5-e8c9-4d2f-b21e-3c56f48a2b6d}-0.0.0.0
  - 00_STEP7_Prog
  - 01_WinCC_Prog

63. With a double click, open the software 'SIMATIC iMAP' from your desktop. (→ SIMATIC iMAP)

64. First, we have to import the previously generated components 'Import components' to the 'Project Library' (→ Project Library → Import component)
65. Select the path for the components of the first station. (→ station1_start_stop {...})

66. Select the component and then confirm the selection with 'Open'. (→ Station1_Start_Stop → Open)
67. Select the path for the component of the 2nd station. (→ station2_start_stop {…})

68. Select the component and confirm the selection with 'Open'. (→ Station2_Start_Stop → Open)
69. If you now select a component in the 'Project Library', you can view its properties in the window 'Preview'. With 'Drag&Drop', drag the desired components to the 'System Plan' in the 'Plan View'. (→ Station1_Start_Stop → Anlagenplan)
70. In our sample project, arrange the components 'Station1_Start_Stop' and 'Station2_Start_Stop' below the system plan. (→ Station2_Start_Stop)
71. A few properties still have to be set for the components that are now connected to each other. To this end, with the right mouse key click first on 'Station1_Start_Stop' in the network view and select 'Properties'. (→ Station1_Start_Stop → Eigenschaften)

72. In the properties, under 'Addresses', assign the 'IP Address' and the 'Subnet screen form' for the controller contained in the component. (→ Addresses → 192.168.0.1 → 255.255.255.0)
73. Under the tab 'Internal IE devices', assign the 'Device names' and 'IP Addresses' for the IO devices that may be contained in the component. (→ Internal IE Devices → OK)

74. Now, with the right mouse key, click on 'Station2_Start_Stop' in the network view and select 'Properties'. (→ Station2_Start_Stop → Properties)
75. In the Properties, assign under 'Addresses' the 'IP Address' and the 'Subnet screen form' for the controller contained in the component. (→ Addresses → 192.168.0.2 → 255.255.255.0)

76. Under the tab 'Internal IE Devices', assign the 'Device names' and 'IP Addresses' for the IO devices that may be contained in the component. (→ Internal IE Devices → OK)
77. Now, change to the 'Plant View', in order to graphically program the interconnections between the stations. (→ Anlagensicht)

78. By clicking first on the OUT variable and then on the IN variable, you are connecting the ‘OUT Variables’ of one station with the ‘IN Variables’ of the other station. The data type has to match. (for example, → OUT_Start → IN_Start)
79. Now, wire the two stations in our sample project as shown below. Then, click on a wired connection with the mouse, and select its properties (→ Properties).

80. Here, you can change the speed and the failure mode of this connection. Do this for all interconnections in our project, corresponding to the figure. (→ Transmission type cyclical mean value (50ms) → Substitute value: User defined value False → OK)
81. Save your project by clicking on the symbol 'Save'.

82. Select a path and assign a name to the iMAP project. (CPU315F_CBA_iMAP → Save)
83. By clicking on 'Projekt generieren', generate your project ('Projekt generieren').

84. The status of generation is indicated.
85. If your project was generated successfully—which is indicated in the 'Info' window—all devices ('Instances') can be loaded to the station simultaneously. (→ Online → Download all instances → All…)

![Image of a Siemens SIMATIC Station interface with a screenshot showing the project, instances, and online download settings.](image-url)
86. The signal characteristics can be 'monitored' 'online' in the System View. (→ Online → Beobachten)